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TIPS, TRICKS, AND TUTORIALS

Using an IBM-compatible computer’s <Print Screen> key to get
something printed on Hewlett-Packard LaserJets can produce
puzzling results for many people. Does this scenario sound
familiar?

"When | press the print screen key, | have to do so three times
before my printer actually prints anything. Then | get a page
with 2-1/2 copies of what was on the screen. The next time |
print several lines of what was on the previous screen appears at
the top of the page.”

BEHIND THE SCENES

The DOS <Print Screen> (and <Shift> <Print Screen> combination)
feature was designed for people who need to make a paper record of
what is currently on the screen. Page printers, such as the HP
LaserJets, are designed to wait until they receive enough
information from the computer to fill an entire page before
printing it. To accomplish this task these printers use a special
file called a "buffer." The buffer collects the characters that

the computer sends to the printer and keeps track of the number of
lines. When the number of lines in the buffer equals the number
of lines that fit on a page, the buffer signals that it is full,

and the printer initiates the process to compose and print a page.

Pressing the <Print Screen> key sends the characters on the screen
to the printer's buffer. Since the number of lines that make up
the screen are not enough to fill the buffer, you end up pressing
the <Print Screen> key several times. By the third press there's
more than enough information to fill one page. Since the buffer
holds leftover information until it receives enough characters
from the computer to make up another full page, lines from the
“previous” screen appear at the top of the page the next time you
print.

PRINT SOLUTIONS

The printer needs to receive an instruction that tells it to print

a page before its buffer is full. Most software, such as

WordPerfect or POPMail, includes this instruction when you use its
print command. So if you're using a program such as Microsoft
Word or Lotus 1-2-3, we recommend that you avoid using the <Print
Screen> key and use the application’s command to print

information. This way, the printing instructions are relayed by

the program, and you don't have to worry about how much
information is in the printer's buffer.



- One Caution

Some software gets hopelessly confused if you press the <Print
Screen> key and the printer is not turned on. If this happens,
you will probably have to restart your computer to get its
attention.

LaserJet Control Panel

If you use the <Print Screen> key instead of the print command
within a program, you can give the LaserJet instructions that
empties the buffer and print a page. To do this press the buttons
on the printer listed below:

Take the Printer Off-line

1. Press the ON LINE button so the light is turned off.
2. Press the FORM FEED button.

3. Wait until the page is printed.

Return Printer to Original Settings

4. Press the ON LINE button so the light is turned on.

(On other page printers these buttons may have different labels.
For instance, the FORM FEED button might be labeled FF. Other
printers may require you to press a different sequence of buttons.
Refer to your printer manual if these steps do not work with your
page printer.)

From DOS

When you are using DOS you may want to use the <Print Screen> key
to make a paper record of your directory. You can type in
instructions that tell the printer to print a page even though its
buffer isn’t full. This method works only when you are using DOS
(when you can see the command prompt, for example C:>). To issue
the instruction to your printer, follow these four steps:

1. Type
ECHO
and then press the <Spacebar>.
2. Hold down the <Alt> key and type
012
from the numeric keypad, being sure that the <Num Lock> key's
light is on. (You will see AL inserted on your screen. This
step does not work if you use the number keys that appear

across the top of the “typewriter” part of the keyboard.)

Then press the <Spacebar>.



3. Type
>PRN
and press the <Enter> key.

(To get the “>" symbol on most keyboards, hold down the <Shift>
key and press the <.> key.)

4. When you've successfully followed these steps, you will see the
command line displayed below on your screen:

ECHO AL >PRN
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if you cannot find the computer books you want in the Book

Center’s Reference section, tell us what books you want to buy.
Send specific titles or areas of interest to: Maureen QO'Brien,

160 Williamson Hall, Minnesota Book Center, 231 Pillsbury Drive
SE, Minneapolis, MN 55455. Here’s what is new in the Reference
section:

"Macintosh Bible, Guide to System 7" by Rubin, a Goldstein and
Blair publication for $12.

"The Little DOS 5 Book" by Nelson, a Publishers Group West
publication for $29.95.

"DOS Power Tools, Techniques, Tricks, and Utilities revised for
DOS 5.0" (3 disks included) by Somerson, a Bantam publication for
$49.95.
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These offers are made to University departments, employees, and
students. The regular Microcomputer Discount Program rules of
eligibility apply. If you have questions about availability,
phone the Electronics Desk at 625-3854.

Those with access to electronic mail and the University’s internet
and BITNET can get product and price change bulletins for the
products sold through the Electronics Desk. To be added to the
mailing list, E-mail a request to:

request@boombox.micro.umn.edu

Once you are on the mailing list, you will receive notification
via E-mail as soon as we have new prices or products.

ZEQS PRICE CHANGES

Recently there were several changes in the ZEOS product line

available through the Microcomputer Discount Program. The prices
for most units decreased, and the size of the hard disk included

with some packages increased from 124MB to 130MB. A few
configurations were added, and the following lines are no longer
available: 386SX-16, the 486-25 with 0 cache, and the 486-33 with
0 cache.

The Notebooks 286 and 386SX are unchanged. The table below lists
the current prices for the products that did change. In the table
the Hercules and the VGA monitors are monochrome. For more
complete descriptions of all the ZEOS configurations, see the
"ZEOS MS-DOS Compatibles" handout. Handouts are available at all
the Microcomputer HelpLines.

TABLE 1: ZEOS PRICE CHANGES
To see this table, you must obtain the original paper copy.

MORE IBM CHANGES

IBM recently announced several changes to their product offerings
and prices. Besides the new machines reported in this
newsletter's news section, IBM upgraded some PS/2s without
increasing their price and changed the items they are bundling
with selected PS/2s. The enhanced products and the bundles are
listed in separate tables below.

The Models 30/286, P70, 90, and 95 are available only as special
orders; and, as announced in June, IBM withdrew the 50Z and 65SX
from marketing. The Model 80-A16 configuration was added to the



. discount program; its price is $4356. The 80-A16 is a 25MHz 80386
system that comes with 4MB of RAM, memory cache, and a 160MB hard
disk.

Complete descriptions of these and other IBM PS/2s are available
in the "IBM PS/2 Computers" handout, which is available at all the
Microcomputer HelpLines.

Enhanced PS/2s

IBM recently upgraded the PS/2s listed below without increasing
their price. The enhanced configurations come with 4MB of RAM
instead of 2MB and have larger hard disks with faster access
times. The access times of the older hard disks range from 39-23
milliseconds. You may have noticed that the old PS/2s’ part
numbers are tied to the size of their built-in hard disk. Since
these configurations have larger hard disks, their part numbers
also changed.

TABLE 1: ENHANCED PS/2s
To see this table, you must obtain the original paper copy.

Bundle Changes

For several years IBM has bundled some of their personal computers
with software and accessories. These bundles are national
promotions, and the items IBM has bundled with their machines has
varied greatly over time. Although the items included in the

current bundles vary, all the bundles, except the portable L40SX,
come with an IBM color monitor and an IBM mouse. All the bundles,
including the L40SX, come with Microsoft Windows 3.0, Toolbook 1.5
(runtime), and Entertainment Pack.

At press time the Microcomputer HelpLine had disks and manuals for
only some of the software included in the bundles. The HelpLine
does not have any of the multimedia equipment. Although the
software is pre-loaded on the machine’s hard disk, IBM is

including master disks and manuals for all the major major

software in the current bundles. To help you calculate the

bundles’ savings, we've included prices of bundle items that the
Book Center routinely sells.

TABLE 2: IBM BUNDLES
To see this table, you must obtain the original paper copy.
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NEWS AND ANNOUNCEMENTS

Our ENCORE UNIX, VAX VMS, and CYBER NOS systems will run in
unattended mode from midnight September 1st until midnight
September 2nd. Normal operations on all these systems resume at
midnight September 2nd. It is unlikely that any tape requests or
printing will be processed during these hours.
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NEWS AND ANNOUNCEMENTS

We will remove the last of our seven-track tape equipment from
service on October 1, 1991. This change will be important for
some people who use the UX, VX, VZ, and CA central computers.
After October 1st, we will no longer be able to read or write

tapes in the seven-track format. Few modern computing systems
still read seven-track magnetic tapes. Only our CYBER CA still
reads seven-track format. If you own seven-track tapes, you
should convert them as soon as possible. (Since the CYBER CA will
be phased out next year, if you have CYBER tapes of any format,
you should begin converting them as soon as possible.)

To speak to a consultant about converting your tapes, call the UX,
VX, VZ, and CA central computing Help Line at 626-5592.

Is It 7- or 9-Track?

If you don’t know what format your tapes are in, this guideline
may help: if you wrote your tapes with one of our VMS systems, it
is undoubtedly a nine-track tape.
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ENVIRONMENT: A MENU-DRIVEN UTILITY ON VMS

Save Time and Work with ENVIRONMENT

TYPICAL SCENARIOS

Let's begin with a hypothetical situation.. Mary and Susan walk
into the computer lab to work on a class paper. They sit at
identical terminals and both log onto the same VMS system. When
Mary is typing the command to call the editor, she can see that
Susan, after typing a few keystrokes, is already working on her
paper, which is displayed on the screen.

After a few revisions, both papers are done. Mary and Susan
decide to print out their files. While Mary is typing the "PRINT"
command that will direct her formatted output to a bin on the
Lauderdale output shelves, she sees that Susan walks towards the
laser printer in a corner of the lab where her paper is already
printing.

Although both were working on the same system, Susan’'s working
environment allows her to cut corners and make her work easier and
more efficient. That is, Susan is not using default settings for

her commands. Instead, she’s taking advantage of another set of
pre-selected options.

Susan may have a tailored environment for several reasons. She

may have consulted her manual to learn about VMS commands, or read
the "Welcome" on-line document and obtained a few ideas from

there, or, most likely, she talked to a friend or consultant who

told her which instructions to use for her settings.

If you feel that you have something in common with Mary and her
inability to cut corners as Susan did, the ENVIRONMENT program may
be for you. If you already know how to modify your environment in
some ways, ENVIRONMENT may still teach you more.

ENVIRONMENT'S INTERFACE

ENVIRONMENT is a VT100-compatible program developed by the
Computer and Information Services’ VMS group. It has an easy-to-
use interface that lets you select “action icons,” different
possibilities for your login and default work settings.

Using the arrow keys on your terminal keyboard, you move up and
down and left and right among the icons and make your selection by
pressing the <Return> key. Some selections have additional

options. These will be presented as pop-down menus on your

screen. If you need more guidance when you're using ENVIRONMENT,
you can consult its built-in help facility. To set your terminal

to a VT100-type, use the following VMS command:



.set terminal/vt100

ENVIRONMENT allows you to:

* customize your "PRINT" command

* speed up your login time

* select default editors for several VMS utilities

* use your own name when communicating with others

* and request changes on your VMS validation

In this section we discuss all the options and settings you can
use.

You can set up a default PRINT command for DCL, Mail, ListDoc, and
Notes by selecting a printer, characteristics, forms, and
destination from menus. The menus list all the printers available
for general users and the most commonly used print options. To
add more options, edit your default "PRINT" command.

Speed Up Login

You can see and change login options that determine how often you
receive notices about:

* newly arrived BITNET files — daily or at each login

* newly posted News — daily or at each login

* resources used by your account — daily or at each login

* newly arrived mail — never or at each login

A note of caution about the frequency choices above: if you select
daily or never, you should make your own provisions to find out
the information.

* for BITNET files, use "RECEIVE"

* for News use "NEWS"

* for Mail use "MAI"

* for resources consult the command "ACCSTOTL"

And More
You can see and change the default editor for DCL, Mail, ListDoc,
and/or Notes and optionally add special editor commands.

You can set up your terminal type from a menu that lists the most
commonly used terminals types.

So other users can easily identify you, you can set up your
“personal name” with DCL, MAIL, and NOTES. Thereafter, the name
you selected will show instead of your VMS user name.

You can see and request validation changes on your:
* disk quota space,

* working set, and

* CPU time limit.



KEEPING TRACK OF YOUR SELECTIONS
Once you make your selections, ENVIRONMENT keeps track of them in
different ways and places: on the system user's ENVIRONMENT
profile, in the "environment.com” file that is placed in your
default login directory, or in the VMS validation file.

In addition, ENVIRONMENT may send mail to the user name CONSULT to
request validation changes that cannot be made without previous
approval. If the validation that you requested cannot be granted,

a consultant will contact you about it.

RUNNING ENVIRONMENT
To use ENVIRONMENT, set your terminal type to VT100 and at the $
prompt type the full name

ENVIRONMENT
or the abbreviated form
ENV

For help, press the "PF2" key on your terminal keypad. For each
step, you will get help related to the menu you see on your
screen. To exit from any menu, select the "EXIT" icon or press
the "PF4" key.

BEYOND ENVIRONMENT

ENVIRONMENT cannot customize all your work settings. To help you
work even more efficiently and make your work still more pleasant,
use the tailored procedure files and/or logicals and symbols.

Use the procedure files to execute a series of commands upon a
single statement — the calling of the procedure. Use logicals and
symbols to define “working spaces” (directories and subdirectories
or devices) as well as commands that you use frequently. For more
information about these, consult the "Working Environment" section
of the "Welcome" document, available on-line through ListDoc.

Please let us know of problems you encounter running ENVIRONMENT
and of other features that you think of that may be helpful. Send
your feedback to us at these BITNET E-mail addresses:

George Karipys at  George@umnacvx
Dave Nieters at Daven@umnacvx
Marisa Riviere at Marisa@umnacvx
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EXCEL 3.0 FOR WINDOWS AND THE MACINTOSH

Microsoft Excel is a spreadsheet program for Macintosh and IBM-
compatible computers that combines spreadsheet capabilities with
business graphics and database features. Version 3.0 of Excel was
designed to provide a consistent user interface across the

Macintosh and Windows environments. Because of this consistency,
we will talk about Excel in general. If differences occur between
the Macintosh version and the Windows version, we will point these
out.

Our readers who just want an overview of Excel 3.0's new features
can skip ahead and read the section called "What's New in Version
3.0."

HARDWARE AND SOFTWARE REQUIREMENTS

Before reading the rest of the review, it might be helpful to know
if Excel 3.0 will work on the equipment you own. Since it
requires a lot of RAM (random access memory) and storage space,
Excel 3.0 will not perform adequately on some hardware setups.
With all of its features installed, Excel 3.0 uses 3+megabytes of
disk space.

Macintosh

To use Excel version 3.0 you need at least a Mac Plus and System
6.0.2 or later. We also highly recommend that you have a hard
drive. If you have a two floppy drive system, one drive must be
the 1.44MB FDHD SuperDrive.

Excel 3.0 supports Apple’s new System 7.0. If you use System 7 or
MultiFinder under System 6.X, you need at least 2MB of RAM.

IBM and Compatibles

To run Excel 3.0 for Windows you need a personal computer with an
80286 microprocessor or higher, at least 1MB of RAM, and a hard
drive with @ minimum of 2.5MB of free disk space. You must also
install Microsoft Windows version 3.0 or later. (Windows 3.0 must
be purchased separately.)

An EGA-quality or higher monitor, such as the VGA, and a mouse are
highly recommended. For best performance, we recommend that you
have at least 2MB of RAM and run Excel on at least an 80386SX-
based machine.

WHAT IS A SPREADSHEET?

Spreadsheet software is frequently used to help manage budgets and
create sales reports. You can also use spreadsheets to manipulate
statistical information and create small databases.



A typical spreadsheet looks like a sheet of grid paper. Excel and
other spreadsheet programs, such as Lotus 1-2-3, call their
documents “worksheets.” Worksheets consist of rows and columns.
Each intersection of a row and column is referred to as a cell.

You enter your data into the worksheet's cells. If you have the

right equipment, Excel lets you create a worksheet with over 4
million cells (16,384 rows by 256 columns).

Because Excel is multi-purpose software, not all data is stored in
worksheets. Different types of data are stored in different

forms. Excel allows you to create charts for visual

representation of your data, macrosheets to customize your data
and automate tasks that you perform frequently, and templates for
quick creation of your most commonly used worksheets.

WORKSHEETS

You can store, manipulate, calculate, and analyze data such as

text, numbers, and formulas in worksheets. In the example shown
in Figure 1, you can see that we have entered some text and
numbers. We also entered a formula in cell B15 to calculate the
sum of cells B11, B12, and B13.

FIGURE 1: SIMPLE SPREADSHEET
To see this figure, you must obtain the original paper copy.

A feature new to Excel 3.0 is the Toolbar. The Toolbar is located
between the Menu bar and the Formula bar. As shown in Figure 2,
the Toolbar is a row of buttons. The buttons are represented as
icons that you can use for formatting cells, summing ranges of
cells, and creating several spreadsheet objects such as lines,
squares, circles, charts, text boxes, outlines, and buttons.
Macrosheets and Charts also have a Toolbar.

You can easily format cells in your worksheet by using the
Toolbar’s buttons or by choosing options under the "Format" menu.
In Figure 3, you can see how the look of our worksheet changed
when we used some the Toolbar’s formatting buttons to center and
bold some text.

FIGURE 2: TOOLBAR

FIGURE 3: MORE COMPLEX WORKSHEET
To see figures 2-3, you must obtain the original paper copy.

Autosum Button

A Toolbar button that we expect people to use frequently is the
Autosum button, which is shown on the right. In our example, we
selected cell B15 and then clicked on the Toolbar’'s Autosum



~ button. When you select Autosum, Excel automatically enters the
Sum function and uses a range of numbers that are above or to the
left of the selected cell. Since the formula view is off, Figure

3 does not show the formula Excel created; that formula is
=SUM(B11:B13).

Graphic Buttons

We used the Toolbar’s rectangle tool and the text box tool to
create the "Al's Meats" logo you see in Figure 3. We copied the
pig from a graphics package.

LOOKING GOOD IS EASIER

Excel has many features that can help you create better looking
spreadsheets. These features include text wrapping and style
sheets.

Text Wrapping
New to Excel 3.0 is the "Alignment” menu’s "Wrap Text" option that
lets you display multiple lines in a single cell.

Style Sheets

If you use styles, you will be happy to know they've been added to
Excel 3.0. You can apply styles to worksheets, macrosheets, and
charts. A limitation of Excel's styles is that they are not

shared across documents; however, you can copy and paste styles
from one document to another.

Once you've used styles, you may find it hard to do without them.
A style is a name for a collection of formatting features. For
example, you may frequently create headings in your worksheet
using a 14 point Times font that is italicized and center aligned.
You can create one style that applies all these formatting options
to selected cells.

Selecting the "Format" menu’s "Style" command presents you with
the dialog box shown in Figure 4. You define your styles using
this dialog box, and your definitions are recorded in the
"Description" box. We used the name "Heading" for our style.
When you click on the "Add" button shown in Figure 4, the style
name is added to the Toolbar’s styles menu. (In Figure 2 the
drop-down styles menu displays the name Normal.)

FIGURE 4: STYLE DIALOG BOX
To see this figure, you must obtain the original paper copy.

Charts are useful when you want to present your data grapically.
You can create Excel charts two ways: as a separate document or
directly on your worksheet, alongside your data. To create a



- chart on your worksheet:

* select a range of cells in your worksheet

* click the Toolbar's "Chart" button

* drag to select the area the chart should cover on your
worksheet, and

* press the <Enter> key.

Excel will automatically create a column chart, the default chart
style. For Figure 5 we created a chart to represent the text and
numbers in cells A11 through B13.

FIGURE 5: A SIMPLE CHART
To se this figure, you must obtain the original paper copy.

Excel has 68 built-in chart types, such as picture and 3-D, as
well as 44 predesigned charts that include area, bar, column,
line, pie, scatter, and combination charts. You can even import
graphics to use as data-series markers to create "USA Today" type
charts. We used this feature in Figure 6 to turn the standard
black columns into stacks of pigs.

FIGURE 6: IMPORT GRAPHICS
To see this figure, you must obtain the original paper copy.

You can resize charts and other graphics that you place on your
worksheet and position them anywhere on the worksheet. Whenever
you update your worksheet data, your chart also gets updated.

Figure 7 shows our completed worksheet.

FIGURE 7: COMPLETED WORKSHEET
To see this figure, you must obtain the original paper copy.

MACROS: LOOK MA, 'M PROGRAMMING

You can use macros to automate repetitive tasks, to create special
calculation functions, and to customize Excel. For example, the
University’s 1991-92 budget program uses custom designed macros.

To create Excel macros you either record your keystrokes using the
"Macro Record" feature or manually write macro commands onto a
macrosheet. Macros use special functions; these functions are
referred to as Excel’s Macro Language. Whether you use the record
feature or write your own macros, they are stored on their own
macrosheets.

The trick to running macros is that you must open the macrosheet
before you try to run the macro. To avoid having to open multiple
macrosheets, you can store many individual macros on a single
macrosheet.

You can execute a macro four ways:

1. Choose "Run" from the "Macro" menu.

2. Define your own keyboard shortcut.

3. Use the Toolbar’s button feature to create a button on your



- worksheet. (When you press the button, the macro will run.)

4. Include the new "ON.RECALC" function in your macro (then Excel
will automatically rerun the macro to recalculate changes you make
to the worksheet).

TEMPLATES

Templates are like forms. A template for Al's Meats would include
the logo, the worksheet section without the amounts filled in, and
the Total section with the proper formula placed in an appropriate
cell.

When you open a template, Excel creates a copy of the template,
preventing you from accidentally destroying the original. To
create a template you cannot save the worksheet in the usual
manner. You must specifically save the worksheet as a template,
an option you’ll find in the "Save" dialog box. After you've
created a template and stored it properly, when you choose "New"
from the "File" menu, you will see your template names listed
along with your other options.

Figure 8 shows how the "New" dialog box appears after we've
properly set up the Al's Meats template. Now if we need to create
a new monthly report for Al's Meats, we can simply choose the
template from the New dialog box.

In the Windows version you store templates in the startup
directory called "XLSTART." On the Macintosh, you can store
templates in the Excel Startup Folder; this folder goes in your
System Folder.

FIGURE 8: TEMPLATE ADDED TO NEW MENU
To see this figure, you must obtain the original paper copy.

PRINTING

You use the "File" menu's "Page Setup" command to select the
page’s layout, such as set headers, footers, margins, chart size,
paper orientation, and paper size. You can also control whether
or not row and column headings and gridlines will print. Other
fine tuning options allow you to control where the page breaks
occur, set up row and column titles, and center the document on
the page.

The "File" menu’s "Print Preview" command allows you to see how
your worksheet or chart looks before you actually print it. You
can view your worksheet or chart in actual size or reduce it so
that one full page will fit in the preview window. New to Excel

3.0 is the ability to change margins and column widths from within
Print Preview.

In the Windows version of Excel 3.0, your printer is set up within
the Windows environment. However, you can still change your
printer settings within Excel by choosing "Printer Setup” from the



"File” menu. Be careful about the printer options you choose.
For example, if your printer does not support Landscape (wide)
orientation, Excel cannot make it print in Landscape.

CONVERTING BETWEEN MACs AND IBMs

Excel 3.0 for the Macintosh and for Windows was designed to have a
consistent look and feel, i.e., a consistent user interface. For

the most part we found this to be true, and, importantly, both
packages use the same macro language.

While working on the University’s budget project we used Apple
File Exchange to successfully convert many worksheets and
macrosheets from the Macintosh to the Windows version. One
translation limitation we encountered was the eight character
limit for DOS file names. When creating worksheets and
macrosheets for both the Macintosh and the Windows environments,
you must keep file names short. If you do not keep this
difference in mind when you create macros that call other
macrosheets, your macros will not work until you shorten their
names (including changing the cells in the macro that do the
calling).

Keyboard Differences

We noticed some relatively minor differences in keyboard commands.
To invoke a macro keyboard shortcut on the Macintosh, you press
<Option>, the "command" key, and the letter you assigned. In the
Windows version you press the <Ctrl> key and the letter you
assigned.

On the Mac you can use the <Return> key to move down one cell; to
do this in Windows you must use the "down” arrow key. Unless the
Mac has an extended keyboard, it has no equivalent to the <Home>
and <End> keys you can use in Windows.

ADVANCED FEATURES

Excel supports features that are handy for people who create large
spreadsheets. These features include data consolidation, goal
seeking, and database functions.

Data Consolidation

The "Data" menu's "Consolidate" feature allows you to consolidate
multiple worksheets into one. You can use this handy feature to
create a year-end report from data on spreadsheets that were
created monthly. To use data consolidation you link your
destination area (e.g., the year-end report) to the source areas
(e.g., the monthly spreadsheets). When destination areas are
linked to source areas, your consolidated data is updated whenever
you change the source data.

Goal Seeking



Goal seeking allows you to perform “what-if" analyses. Say, for
example, that you want to earn a certain amount of interest this
year on your savings accounts, but you're not sure how much money
you'll have to save each month to achieve your goal. You could

use the "Formula" menu’s "Goal Seek" option to calculate the
amount of money needed to earn a certain amount of interest. Goal
seeking is useful when you know the answer, but you're not sure of
the variable amounts needed to get your answer.

Database Functions

You can manage a small database on a worksheet using standard
database operations. Excel limits you to one database per
worksheet. You can use Excel’s twelve database functions to
calculate, find, and extract data.

Databases in Excel are different from standard database packages
such as FileMaker Pro for the Macintosh or Paradox for IBM and
compatibles. When you open an Excel worksheet, it is loaded into
RAM. Therefore, the size of Excel databases and worksheets is
limited by the amount of memory in your computer. Since standard
database packages store the database on disk and load into memory
only those records you request to view or change, they're a better
tool for large databases.

Due to the differences between the two operating environments, the
Windows and Mac versions of the "User's Guide," "Getting Started,"
and "Quick Reference Guide" are slightly different. The Windows
and Mac versions of the "Excel Solver User’'s Guide" and "Function
Reference Guide," however, are exactly the same.

Besides the manuals listed above, the Mac and Windows versions
come with the additional manuals listed below.

The Macintosh version comes with a "Database Access User’'s Guide."
This guide is for System 7 users and includes directions on
accessing data from external databases using Apple’s new Data
Access Language (DAL).

The Windows version includes manuals entitled "Using Help for
Lotus 1-2-3 Users and Q+E User's Guide." Q+E allows you access
to external databases.

If you purchase the version 3 upgrade to the Mac or the Windows
version, you also receive the "Upgrading to Version 3.0" manual.
This manual explains the new features of Excel 3.0: the Windows
and Mac manuals are exactly the same. (This manual does not come
with new copies of Excel; it comes only in the upgrade packages.)

WHAT'S NEW IN VERSION 3.0



- Those using an earlier version of Excel may wonder if they should
upgrade to version 3.0. Below we've listed a few of Excel 3.0's
new features:

* automatically adjust columns to optimum widths

* outline view helps you organize data

* assign macros to a button or another object on the worksheet
(click the button or object to run macro)

* define documents as templates

* adjust margins and page setup settings in Print Preview

* consolidate data from several worksheets into one

* create 3-D charts

* create charts directly on worksheets

* place graphic objects on worksheets

* tools to draw lines, rectangles, ovals, and arcs directly on
worksheets

* create text boxes on worksheets

* a Toolbar you can use to format and apply styles to cells on
your worksheet

* a Toolbar button that lets you automatically sum rows and
columns

Upgrading to 3.0

The bad news is that the Book Center does not get discounts on
upgrades. The good news is that because the University gets such

a good discount on Microsoft products, buying a new copy from the
Book Center is cheaper than buying the upgrade. The Book Center
sells new copies of Excel 3.0 for the Mac for $125 and for Windows
for $115. (When you purchase the Excel 3.0 upgrade from Microsoft
your cost is $129 plus $5.50 for shipping and handling.) The
difference between the new and the upgrade packages is that the
upgrade includes a 46 page booklet that is a quick introduction to
Excel's new and changed features. The Microcomputer HelpLines
have copies of this "Upgrading to Version 3.0" booklet that you

can look over.

Departments that want to order several copies can place a special
order for a “10-Pack” of Excel 3.0 for the Mac for $720.
Microsoft does not offer a similar discount for multi-packs of the
Windows version.

For more information on upgrades, contact Microsoft at 800/426-
8400 and identify yourself as an “end user.”

Overall we were pleased with Excel 3.0's performance and the
consistent interface between the Mac and the Windows versions.

The consistent interface is a plus for people whose offices have a
mixture of Macs and IBMs because it makes moving from one machine
to another much easier. The consistency also makes it easier to
create worksheets, templates, and macros that can be used in both
environments. With the exception of naming your worksheets and
macrosheets, the translation between the Windows and Mac versions
is very smooth.



The Toolbar makes formatting much easier, and the ability to use
graphics allows you to create better looking worksheets and
charts. In all, version 3.0's features add more power to Excel.

For the most part the documentation is well organized and
complete. The documentation on macros, however, tends to be
sketchy. We would like to see the "Macro Function Reference”
guide expanded and see more information about writing macros and
using macro functions.

We would not run Excel 3.0 on a Macintosh without a hard drive;
it's too large to run satisfactorily on a floppy based system. We
also would not consider running Excel for Windows on an 80286-
based machine. On that kind of a hardware setup it's too slow.

For all Windows applications we recommend at least an 80386SX-
based machine.

We experienced memory-related problems when using the Windows
version of Excel with large documents containing different fonts
and styles. However, the error message “Not enough memory to
display completely” is a Windows message, not an Excel related
problem. To eliminate the message and the problem, we used fewer
fonts and styles and closed other Windows applications that were

open.
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FREE SOURCE CODE FOR MATHEMATICAL AND STATISTICAL ROUTINES VIA E-MAIL

Electronic mail systems are generally used to send messages from
one person to another, but it is also possible to use internet E-
mail to automatically distribute information to a large,
geographically-dispersed audience. Imagine a program that reads
E-mail sent to it and can respond to commands it receives in the
mail messages sent to it. This sort of program could
automatically respond to requests by sending an E-mail reply to
the person that sent the request. With this sort of system, it
becomes economical to automatically send text to anyone who
requests it. Well, this sort of system is available to distribute
source code for mathematical and statistical routines you might
use in writing your own software.

NETLIB AND STATLIB

NETLIB and STATLIB are automated E-mail systems that distribute
public domain source code for mathematical and statistical

routines. NETLIB contains a wide range of mathematical software,
including numerical linear algebra, linear programming, nonlinear
optimization, curve fitting, special functions, fast Fourier
transforms, the numerical solution of ordinary and partial
differential equations, and more. As you might expect, STATLIB
contains a wide range of statistical routines.

Since you get source code, you must have compiler (such as

Fortran, C, or Pascal compiler) to actually use these routines.
Because this is public domain software, there are no guarantees of
quality. Much of the code, however, is nationally recognized for

its quality. We recommend that you carefully test and check each
routine. In particular, look for machine constants in the codes.
Machine constants for a CRAY might produce incorrect results when
used on an IBM PC.

ACCESSING NETLIB AND STATLIB

To obtain index files and software from NETLIB or STATLIB, you

send electronic mail to the appropriate internet E-mail address.
Because all the University’s central systems can send and receive
internet E-mail, anyone with an account on the ACS Encore, ACS

VAX, HSCS NOS, or SPCS IBM can access NETLIB and STATLIB.
Moreover, Macintosh and IBM-compatible users who run POPMail and
workstation users connected to the campus internet can also send
internet E-mail to access these systems. Figure 1 contains E-mail
addresses for the NETLIB and STATLIB E-mail systems.

FIGURE 1: E-MAIL ADDRESSES

netlib@ornl.gov
netlib@research.att.com



étatlib@lib.stat.cmu.edu

To use the systems, you also need to know what commands the NETLIB
and STATLIB servers understand. The requests are one-line
commands that can be the subject part of your mail message or the
message itself. Figure 2 has sample commands. In response to
commands you send, NETLIB and STATLIB will E-mail an appropriate
response to you.

When you access NETLIB or STATLIB, don't ask for an entire
library, such as LINPACK. Complete libraries are much too large
to send. Instead, ask for specific routines.

FIGURE 2: SAMPLE COMMANDS AND EXPLANATIONS

Samples Explanations
send index Send an index of the libraries.
send index from eispack Examine the full index for any

library eispack.

find cubic spline Search for all software with the
keywords cubic and spline.

send dgeco from linpack Retrieve DGECO and all routines
it calls from the LINPACK library.

send only dgeco from linpack Retrieve just DGECO and not
subsidiary routines.

send dgeco but not dgefa Retrieve DGECO and subsidiaries,

from linpack but exclude DGEFA and
subsidiaries.

send list of dgeco from Retrieve just the file names

linpack rather than the contents. This

can be helpful when you already
have an entire library and just

want to know what pieces a
particular application needs.

Some of the NETLIB libraries are already on the ACS VAX VX system
and in CMLIB. The ENCORE UX system has local copies of LINPACK
EISPACK, MINPACK, and QUADPACK.

NETLIB Update

Two locations run the NETLIB E-mail system for the distribution of



. the source code for public domain mathematical software. They
don’t have exactly the same software, although the differences are
small. We understand that the system managers try to make them
match up periodically.

The following routines have recently been added at
NETUB@RESEARCHATT.COM

KINKAID/CHENEY
Programs from the 1990 text "Numerical Analysis: The
Mathematics of Scientific Computing.”

The following has recently been added to both NETLIB@ORNL.GOV and
NETLB@RESEARCHATT.COM

STRINGSEARCH
String matching programs.

STATLIB Update

The following have recently been added at STATLIB@LIB.STAT.CMU.EDU

*  CMLIB
Fortran Core Mathematics LIBrary from the National Institute
for Standards and Technology.

*  ASASCS
Material related to the American Statistical Association’s
Statistical Computing Section.

* MUG
Minitab macros from the Minitab User Group.

*  MIS
Minitab Industrial Statistics macros.

* DESIGNS
Designs, algorithms, and programs for creating designs.

LIBRARY DESCRIPTIONS AND MORE

You can get a current list of the NETLIB and STATLIB libraries and
a more complete description of the commands by sending an E-mail
message with the subject line

send index

to the appropriate server.
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NEWS AND ANNOUNCEMENTS

Hewlett-Packard recently announced another 4 page-per-minute, 300
dots-per-inch (dpi) laser printer: the LaserJet IlIP. Some of the
IIIP’s features are highlighted below. For more information on

this and other laser printers sold through the Microcomputer
Discount Program, see the "Printers for IBM-Compatible Computers”
handout, which is available at all the Microcomputer HelpLines.

Part Description Discount Price

33481A  HP LaserJet llIP (toner and cable not included) * $899

92275A  black toner cartridge * 65
33417B  AppleTalk interface (cable not included) 195
(you can install this interface yourself)

33439P  PostScript cartridge 548
33474B 1MB memory board (HP) * 195
33475B 2MB memory board (HP) * 300
MBIN2  2MB memory board (not HP) 225
33472A  lower letter paper cassette,

includes 250 sheet letter tray 137
Printer Cables
C304-9 shielded parallel: 6 feet $14
C-1A-10 shielded parallel: 10 feet 18
17255D  25-pin serial cable: 1 meter 30
24542G  9-pin serial cable: 3 meters 40

* Prices reduced respectively from $975, $80, $295, and $570 as we
went to press.

When you purchase the LaserJet IlIP you get a power cable, user
manuals, and a one year warranty. The IIIP uses the same toner as
the LaserJet IIP; other HP laser printers use different toner
cartridges. At press time the Microcomputer HelpLine in 125
Shepherd Labs did not have a LaserJet llIP avaitable for “test
drives.”

Resolution Enhancement

Like the other printers in the LaserJet Ill series (the HI, 1D,
and WlISi), the IIP runs under HP’s PCL5 (printer control
language 5) and HP's resolution enhancement technology is built
in. To achieve enhanced resolution, HP uses a proprietary circuit
that can move dots or intelligently adjust their size and position
in relation to neighboring dots. These adjustments result in
smoother edges on curves and angled lines than you see on other
300 dpi laser printers.



When you purchase a llIP you get the same fourteen fixed size
(bitmapped) and eight scalable (outline) typefaces that come with
the LaserJet lll.

The built-in fixed size fonts are listed in the table below.
Courier comes in 10 and 12 characters per inch (pitch).

Fixed-Width Fonts Portrait (normal) Landscape (wide)
Courier Medium 10 and 12 pitch 10 and 12 pitch
Courier Bold 10 and 12 pitch 10 and 12 pitch
Courier ltalic 10 and 12 pitch 10 and 12 pitch

Line Printer 8.5 point 8.5 point

HP's PCLS5 includes Agfa Compugraphic’s Intellifont. If you have
compatible print drivers, Intellifont allows you to scale
compatible fonts from .25-999.76 points. The 1lIP’s built-in
scalable fonts are listed in the table below.

Scalable Fonts Normal Bold Italic Bold ltalic
CG Times (a serif font) X X X X
Univers (a san serif font) x X X X

The llIP has one font cartridge slot and is designed to be
compatible with the font cartridges and printer drivers available
for HP’s older LaserJets. However, all of the LaserJet drivers
cannot take advantage of the IlIP’s newer features. If you use

the llIP with the PostScript cartridge, you will need at least 2MB
of memory in the printer.

Other IlIIP Features
You can use the same memory in the IIIP that you use in the
LaserJets IIP, 1ll, and HID.

The IlIP comes standard with 1MB of memory and is expandable to
S5MB. Unlike the LaserJet IIP, IID, and IlID printers, the 1MB of
RAM in the IlIP is sufficient to print text on legal size paper.
However, if your pages include a lot of graphics, you may need 2MB
to print on legal size paper. The IlIP has two expansion slots

for memory.

Built-in parallel and serial interfaces are standard on the IIIP,
and you can add HP's AppleTalk interface kit. The IIIP is
designed to fit in an environment where the average monthly
requirements are less than 8000 pages. This capacity positions
the IlIP between the lIP and the IlI.

The IiP’s standard 70-sheet input tray accepts envelopes as well
as letter, legal, A4 and executive paper.
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These offers are made to University departments, employees, and
students. The regular Microcomputer Discount Program rules of
eligibility apply. If you have questions about availability,
phone the Electronics Desk at 625-3854.

HP LASERJET 1IISi ACCESSORIES

The discount prices for optional parts for the Hewlett-Packard

LaserJet llISi increased. The table below lists the old and new

prices for accessories for the IlISi. Some of the IlISi's

distinguishing features are:

* prints at 17 pages-per-minute

* 300 dots-per-inch resolution for text and graphics

* includes two 500-sheet input trays

* optional duplex (2-sided) accessory

* supports HP’s microfine toner

* PostScript on ROM (PostScript requires more memory and
installation by service technician)

The IlISi uses different memory, paper trays, and toner cartridges
than the other LaserJets, but it is designed to be compatible with
the font cartridges and printer drivers available for HP’s older
LaserJets. However, all of the LaserJet drivers cannot take
advantage of the IlISi's newer features. Complete descriptions of
the IlISi and other laser printers are available in the "Printers

for IBM-Compatible Computers" handout. Handouts are available at
all Microcomputer HelpLines.

ISi Price

Part Description Ol New

33491A  HP LaserJet llISi no change  $3025

C2061A  Duplex Accessory 425 475

C2063A 1MB SIMM no change 90

C2065A 4MB SIMM 250 260

33494A Adobe PostScript Upgrade Kit 535 705
(price does not include installation)

92291B Letter Paper Tray 85 105

92291C Legal Paper Tray 85 105

92291D A4 Paper Tray 85 105

92291E Executive Paper Tray 85 105

Optional Network Interfaces

C2059A Novell/Ethernet $425 $470
C2059C Novell/Token-Ring 485 540
C20598B 3Com 3+Open/Ethernet 425 470

C2059D 3Com 3+Open/Token-Ring 485 540
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These offers are made to University departments, employees, and
students. The regular Microcomputer Discount Program rules of
eligibility apply. If you have questions about availability,
phone the Electronics Desk at 625-3854.

IBM MONITOR CHANGES

The 12-inch IBM monochrome monitor P/N 8503 has been replaced by
P/N 8504, a black-and-white monitor that comes on a tilt/swivel
base. The new 8504 has a flatter, squarer tube that reduces glare

and provides a larger viewing area. The 8504’s very low frequency
magnetic fields meet Swedish standards. The Book Center’s price

for the 8504 is $206.

The 8504 is a white phosphor analog monitor that is a good
companion for the VGA adapter that is built into all PS/2s. When
used with the VGA adapter, it supports 640 x 480 resolution with
up to 16 shades of grey and 320 x 200 resolution with up to 64
shades of grey. At press time the Microcomputer HelpLine in 125
Shepherd Labs did not have a display model of the 8504 monitor.
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NEWS AND ANNOUNCEMENTS

With IBM’'s new optical drive you can store up to 127 million bytes
on one small cartridge. This drive lets you write to the disk,

read from the disk, and revise what you've saved to the disk. You
insert the cartridge disks much like you insert floppy disks. To

use this optical drive, your system must be running DOS 5.0, OS/2
Standard Edition 1.3, OS/2 Extended Edition 1.3, or DOS 4.0. When
you use it with DOS 4.0 you cannot use the DISKCOPY and DISKCOMP
functions.

You can install this 3.5-inch half-height SCSI device internally
on some PS/2 models or externally on PS/2s with a 3510 or 3511
SCSI device enclosure. The optical drive includes the cables,
slides, trays, and bezels you need to use it internally with
supported PS/2s. The drive’'s average seek time is 66
milliseconds. At press time the HelpLine in 125 Shepherd Labs did
not have a display model of this rewritable optical drive.

Part Description Discount Price

6450162 Rewritable Optical Drive $ 1077
38F8646 128MB rewritable cartridges:5-pack *
* Cartridges are currently unavailable at the Book Center. We
expect 5-packs to cost about $325.
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These offers are made to University departments, employees, and
students. The regular Microcomputer Discount Program rules of
eligibility apply. If you have questions about availability,
phone the Electronics Desk at 625-3854.

MAC SYSTEM 7 MANUALS: $45

If you obtained Apple’s new System 7 software from the Mac
Information server, you got very little documentation. You can
now buy the complete set of System 7 documentation for $45.
Although you do not get any disks, you get these four manuals:
"What's New in System 7," "How to Install System 7," "Macintosh
Networking Reference," and "Macintosh Reference," a heavily
illustrated book with over 400 pages.
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NEWS AND ANNOUNCEMENTS

As announced previously in the ACS Newsletter, that branch of
Computer and Information Services previously known as Academic
Computing Services will end its CYBER NOS service on June 30,
1992. We’ll provide more information about the end of this CYBER
NOS service in future issues of the "Computer and Information
Services Newsletter."

NOS 2 is used on a Control Data Corporation CYBER 830, the central
system know as CA. The CA provides interactive and batch
computing for University researchers and students.

Converting Questions?

If you have questions about converting your projects to our VMS or
UNIX systems, please call Michael Frisch at 625-5830. If you're
interested in converting to CYBER NOS/VE or CYBER EP/IX (UNIX)
systems, call 626-8366. If you are interested in converting to
IBM VM/CMS, call 624-6235.
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NEWS AND ANNOUNCEMENTS

IBM recently introduced three new 80386SX machines in their
Personal System/2 line of microcomputers: Models 35SX, 40SX, and
57SX. Through the Microcomputer Discount Program you can purchase
the configurations that are listed in the table below. At press

time the Microcomputer HelpLine in 125 Shepherd Labs had the 35SX
and the 80MB 40SX available for test drives.

Standard Features

All the machines share some features. For example, they can sit
horizontally on a desk or you can place them vertically in a stand
and operate them on their side. The 40SX and 57SX even come with
a floor standing pedestal to hold the system unit in a secure

vertical position. The models’ distinguishing features are
discussed in individual sections below.

All the Models 35SX, 40SX, and 57SX sold through the Book Center

come with

* an 80386SX microprocessor that runs at 20MHz with 0-2 wait
states

* a socket for an i387SX math coprocessor

* a one-year carry-in warranty

*1BM DOS 5.0

* system boards that include a 16-bit VGA display adapter and a
diskette controller as well as parallel, serial, keyboard,
and pointing device (mouse-type) ports

* IBM’s familiar 101-key enhanced keyboard that includes twelve
function keys and three lighted mode indicators

* a power cord and a cable for the keyboard

You can start up (boot) your machine from any disk drive, a useful
feature if your disk drives are different sizes and support disks
of different densities, such as 720K, 1.44MB, or 2.88MB.

Diskette Drives

DOS 5.0, OS/2 Standard Edition, and 0S/2 Extended Edition 1.30.1
support the new 2.88MB media sense diskette drive that is standard
on the 57SX and an option on the 35SX and 40SX. You can use 720K
and 1.44MB diskettes in the 2.88MB drive. The table below shows
the diskettes sizes and their DOS formatted capacity.

Diskette Size  DOS Formatted Capacity
iMB 720 kilobytes
2MB 1.44 megabytes
4MB 2.88 megabytes



Models 35SX, 40SX, and 57SX have three SIMM (Single InLine Memory
Module) sockets on the system board. Two of those sockets are

available for adding additional memory. The system board supports

a maximum of 16MB, which is also the maximum memory that the
machines support.

Manuals

You also get some documentation including a "Guide to Operation,”
setup instructions for your specific machine, and a tutorial
diskette that helps you learn about your system. If you want
technical documentation, you must purchase it separately. The IBM
DOS 5.0 documentation includes keyboard and code pages and two
manuals: "Getting Started" and "User's Guide and Reference.”

Models 35SX and 40SX

Generally the Models 35SX and 40SX are alike. Both feature the
classic AT-type bus and have one 1.44MB 3.5-inch floppy disk
drive. If you purchase the proper adapter you can add an external
5.25-inch 360K drive to the 35SX and 40SX.

The 35SX and 40SX have one 2MB SIMM installed on their system
boards. When you add memory to these machines, you can use 85
nanosecond or faster SIMMs in these sizes: 1MB, 2MB, 4MB, or 8MB.

Caution

Since both the 35SX and 40SX contain hard disk BIOS functions that
are not supported by IBMCACHE.SYS (the IBM disk cache program for
PS/2s), this program is not on their starter diskettes. If you

use this cache program on the 355X or 40SX, you could corrupt the
data stored on the hard disk.

SMARTDRV.SYS is supported. Itis a DOS disk caching program for
computers that have extended or expanded memory and a hard disk.

Model 35SX

You get three full-size 8/16-bit expansion slots with the 35SX.

Its power supply is 118-watt, 50-60Hz with 100-125VAC and 200-
240VAC. The dual voltage is controlled automatically by the

machine’s autosensing/autoswitching feature. The 35SX has two
internal storage bays. In the configuration sold through the

discount program, one bay has a hard disk and the other has a

diskette drive.

Model 40SX

You get more expansion slots, more storage bays, and a larger

power supply with the 40SX than you get with the 35SX. The 40SX
has five full-size 8/16-bit expansion slots and a 197-watt 50-60Hz



. power supply with 100-125VAC and 200-240VAC. You control the dual
voltage with a manual switch on the back of the unit.

The Model 40SX has storage bays for two more internal drives. You
can add a second IBM 40MB or 80MB hard disk and one of the
following diskette drives: (1) a 3.5-inch 1.44MB or 2.88MB drive
or (2) a 5.25-inch 1.2MB drive.

Model 578X

The Model 57SX features IBM's Micro Channel bus with five 16-bit
expansion slots, a SCSI port, and IBM’s new 2.88MB 3.5-inch floppy
disk drive. The power supply is 197-watt, 50-60Hz with 100-
125VAC and 200-240VAC. You control the dual voltage with a manual
switch on the back of the unit.

The 575X can accommodate more combinations of DASD's (direct
access storage devices) than the 355X and 40SX. For example, you
can use the two unused bays of the 57SXs sold through the Book
Center to install two hard drives, two diskette drives, a CD-ROM,
and/or IBM’s new read/write optical drive. IBM has separate parts
for a 3.5-inch 1.44MB, a 3.5-inch 2.88MB, and a 5.25-inch 1.2MB
internal diskette drive; these same drive parts work in the 57SX

and 40SX.

Some of the 57SX’s system programs are stored in a 3MB protected
partition on the hard disk drive. These programs include set
configuration and backup/restore. You also get copies of these
programs on the 57SX’s "Reference Diskette." The hard disk’s
protected partition is unaffected by the DOS or 0S/2 FORMAT
command.

Since the 578X is a more integrated machine than previous PS/2s,
it does not support features such as the PS/2 Micro Channel memory
adaptor options.

SCSI Support

The Small Computer System Interface (SCSI) controller is
integrated into the planar and has an external port. Since the
57SX's internal hard disk is a SCSI device, you can attach only
six other SCSI devices.

......

The 578X is currently shipped with one 4MB SIMM. When you add
memory you must use 70 nanosecond or faster SIMMs. Although the
57SX supports 2MB, 4MB, and 8MB SIMMs, it supports interleaved
memory only with the following combinations of SIMMs:

* one, two, or three 2MB SIMMs

* two or three 4MB SIMMs

The 8MB SIMMSs do not provide interleaving.

PS/2 RAM Hard Disk Discount
Model Size/Speed Price



CPU: 80386SX. Speed: 20 Megahertz.
These basic units come with DOS 5.0 but no monitor.

* 358X-043

8535-061 2MB 40MB/17ms $ 1715
* 408X

8540-043 2MB 40MB/17ms $ 1971
8540-045 2MB 80MB/17ms 2144

* 578X

8557-045 4MB 80MB/17ms $ 2419
8557-049 4MB 160MB/16ms 2784
Bundles

.......

IBM also offers the 57SX bundled with a color monitor and
software. Different bundles come with different software. See
the "Book Center Notes" section for more information on these
bundles.
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PROJECT MINNEXT CALL FOR PROPOSALS

Project MinNeXT is a joint development project between the
University of Minnesota and NeXT Computer Inc. MinNeXT will
support faculty members in developing academic software on the
NeXT platform. In addition, MinNeXT will place machines in
departments that can take advantage of the networking and text-
indexing/retrieval capabilities of the NeXT. As part of Project
MinNeXT, thirty NeXT machines will be awarded to faculty and
departments. Proposals are welcome from all collegiate units and
departments on the Twin Cities campuses.

All proposals will be evaluated through peer review within the
University. For questions about proposal preparation and details

for MinNeXT, call 625-0073. Technical advice is available from

the Faculty Resource Center (626-1090) or Computer and Information
Services (626-4276).

Faculty Proposals

Fifteen NeXTstation Monochrome computers will be awarded to
faculty members proposing to develop courseware for their specific
disciplines. An annual progress report will be required from each
Principal Investigator. The project must be completed within two
years, or the awarded equipment will be recalled. NeXT Computer
Inc. will have no proprietary rights to software or courseware
produced through Project MinNeXT. Use and distribution of
software will be handled according to established University
policies and procedures.

Department Proposals

Project MinNeXT will locate 15 NeXTcube computers in various
departments as part of a distributed file server network. The
NeXTcube will be plugged into the backbone of the University’s
information network, providing access to campus-wide networks.
This special project will allow the University to experiment with
the impact of distributed computing in higher education.

Joint Proposals

Departments and faculty members may submit proposals jointly or
separately. Special consideration will be given to proposals
integrating courseware development on the NeXTstation with
networking on the NeXTcube. We hope that the interaction between
the two NeXT computers will ensure the productive use of both
machines.

PROPOSAL GUIDELINES



- * Proposals may be submitted from individuals and groups on the
University of Minnesota Twin Cities campuses.

* Equipment is available only for the development and evaluation

of new courseware. This project in not intended to solve student
capacity needs. At most, one NeXTstation and one NeXTcube will be
awarded per proposal. Some software may be provided with each
machine based on the Project MinNeXT budget.

* The evaluation criteria for faculty proposals will be the
innovation and impact on instruction. All projects must involve
development of imaginative software, courseware, or novel
application of NeXT technology for instructional use. Only new,
experimental approaches will be considered. Because one of the
strengths of the NeXT computer is its networking capabilities,
projects employing networking functions will receive strong
consideration.

* Awards to departments will be based on need and use.

Departments should explain why they need the computer and who will
use the computer. Departments benefiting most from the productive
use of the NeXTcube will receive first priority.

* Proposals must be 2-4 pages in length, following the Proposal
Outline below.

* Please prepare your proposal with a word processor (Macintosh
preferred). Submit a diskette with your proposal on it, as well

as 10 printed copies of the proposal.

* Submit proposals by September 27, 1991 to Project MinNeXT, c/o
Computer and Information Services. (The complete address is on
the newsletter’s back page.)

Proposal Outline

* Cover Sheet: Must list project title, principle

investigator(s), department, college, campus address, phone
number, and e-mail address. All investigators must sign the cover
sheet. In addition, departmental and college approval must
accompany proposals receiving support from either of these
sources.

* Background: A description of the project area and the course or
courses involved. Include course level, frequency, typical
enrollment and role in the curriculum. Also include the titles of
any textbooks which the project might complement.

* Project Description: Describe what you plan to do, what you
expect to produce, what makes the project innovative, and what
impact it will have on instruction in your discipline on the
national level. Departments should indicate how and by whom the
machine will be used.

* Evaluation: Indicate how you will measure the effectiveness of
your project. This should include a method of gathering
quantitative data to show whether this method of instruction is
helpful to students.

* Schedule: Describe the project's implementation schedule. Base
your schedule on the number of months after the equipment is
obtained. Remember that your award will be recalled if your
project is not completed within two years.

* Resources: List equipment and resources required for your
project, divided into three parts: 1) Equipment provided by NeXT
Computer; 2) equipment and resources provided by the college; and



- 3) equipment and resources provided by Project MinNeXT. The NeXT
list should include only NeXT hardware. The college list should
include programming support, T.A.s, R.A.s, and release time. All
University commitments must be prearranged with your department
chairperson and your dean. MinNeXT can provide a very limited
amount of software and equipment from other manufacturers.
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NEWS AND ANNOUNCEMENTS

We recently added about 50 new entries to the VMS HELP library on
the central system called VX. The VX is a research and

instructional cluster that includes a DEC VAX 6000-510 clustered
with other VAX systems that use the VMS 5.4 operating system.

These new entries are mostly for math and engineering libraries

and packages. We also added "HELP Libraries” and "HELP
Applications" that contain a list of the new HELP entries and a
one-line description for each. In the past, we put help

information for libraries and applications under the "MOREHELP"
command. With these additions to "HELP," we will delete "MOREHELP
Libraries" and "MOREHELP Applications” on September 1, 1991.



. (from August 1991 Computer and Information Services Newsletter)

These offers are made to University departments, employees, and
students. The regular Microcomputer Discount Program rules of
eligibility apply. If you have questions about availability,
phone the Electronics Desk at 625-3854.

WORD FOR THE MAC AND LASERWRITER LS

The latest Microsoft Word update for the Mac fixes the TrueType
font problem for LaserWriter LS users. The Book Center expects to
have free version 4.0D or 4.0G disks available for those who can
show them appropriate proof of eligibility. To get your free
update, bring your master Word disks and University ID to
Williamson Hall.



